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Preface

This user guide describes how to get started with the ATmega168PB Xplained Mini evaluation kit. The
evaluation kit is a hardware platform to evaluate the ATmega168PB microcontroller. The on-board mini
embedded debugger provides seamless integration with Atmel Studio. The kit provides access to the
features of the ATmega168PB enabling easy integration of the device in a custom design.

o A - 3 4
00 0=0-0
0-0 0-0-0[0

E A

L i@t ok

"°/ltmefl

ATmega168PB

© 2017 Microchip Technology Inc. User Guide DS50002636A-page 1



ATmega168PB Xplained Mini

Table of Contents

PrEfaCe. ... e 1
1. INErOAUCTION. ... e 4
T FBAIUIES ...ttt ettt e e 4

L = To = o I O AN T o TP SPTP R 4

2. Getting Started.........ooovviviiiii 6
2.1, Xplained Mini QUICK STaI..........eeiiiie et e e e e e e e ea e e 6
2.2. Design Documentation and Related LiNKS...........ccoiiiiiiiiiiiiii e 6
2.3.  Programming and DEbUGGING........ueeiiuiiiiiiie ettt 6
2.3.1.  Programming the Target Using MEDBG...........ccccciiiiiiiiiiee e 6

2.3.2. Debugging the Target Using MEDBG............cuiiiiiiiiiiee e 8

2.3.3. Programming the Target Using an External Programmer.............cccccooeiriiiiiniieennieenn. 9

2.3.4. Programming the ATmega32U4 Using an External Programmer............cccccoveveniinnnne 9

2.3.5. Programming the ATmega32U4 Using a Bootloader..............cccevviiiiieiiiiniiicie i, 10

G T €] =] 1= To I /1 11
3.1, Mini Embedded DeDUQGET.........coiiiiiiiiii e e 11
3.1.1.  Xplained Mini CIOCK OULPUL........ceiiiiiiiiee e enaaee e e 11

3.2, MEDBG CONfIQUIration.........c.eiiiiiiie et e e et e s e e s e e e e e e e nnneeeanneeenn 12
3.2.1.  MEDBG LOW POWEr MOGES.......cociiiiiiiieiiiie ettt 12

3.2.2. MEDBG FUSE FIllEr....uiiiiieiieiiee e 12

3.2.3. mEDBG Command Line INterface...........cccccercuiiiiiiiiiiiiceiee s 13

3.2.4.  Super User Fantastic Feature Enable Register............cccoviiiiiiiinieci e 13

3.3. mEDBG Firmware Upgrade and Manual Bootloader Entry...........ccccooiiiiiiiniiciiiiic e 14

4, Hardware USer GUIAE..........ccoiiiiiiiiiiiieeeeeeee e 15
4.1, POWET SOUICES. .....cuiiiiiieitii ettt ettt ettt ettt b et ea e s b e et e e bt e bt e nae e ebeesaeeebeesaneenee e 16
4.2, Board ASSEMDIY..... ..o e e e e e e e et e e e e tae e e e e e e annaeeeaeaannes 17
4.2.1.  Connecting an Arduino Shi€ld.............cooiiiiiiiiii e 17

4.3. Target Headers and CONNECIOIS...........cciiiiiiiiiiiie i eeete e e e et e e e et e e e e et e e e e e e snnaeeeaeeaas 17

T e I =T o =Y 4 T - N S 17

4.3.2.  Board POWETr HEAAET........ccoiiiiiiei ettt 18

4.3.3.  Target ANaloGUe I/O......c.uiiiiiiie i 19

4.3.4.  Target Programming..........ccccueeieeiioiiiiieeeeeeiie e e e e et e e e e e st e e e e s eeaneeeaaeeasasaeeaeessntaeeaeeaan 19

4.3.5.  Target ADditional I/O.........ooi i 19

N - o 1= g o= o] g 1=T = | TSR R U UUURRPN 20
441, PUSh BUHON. ..ottt 20

442, USEILED.....iiiiiiet e 20

4.5, MEDBG....c ettt ettt et b e n e 21
4.51. mMEDBG COM Port CONNECHON........ccoiiiiiiiiieiiiie et 21

4.5.2. MEDBG JTAG INtEITACE.......ciiiiiieiiii e 21

4.6.  EXteNSION HEAUGN ATBa........ii ittt ettt 22
4.7.  Factory Programmed....... ...ttt et e et e e e e e e e e e e e e e e nneeeas 23

© 2017 Microchip Technology Inc. User Guide DS50002636A-page 2



ATmega168PB Xplained Mini

5. Hardware Revision History and KNnown ISSUES............ccovviiiiiiiiiiiiiiie e 24

5.1. Identifying Product ID and REVISION...........cociiiiiiiiiiii et 24

5.2, REVISION 5.ttt e a ettt e e e e e 24
6. Document ReVision HiStOrY........oooeuiieiiii e e e 25
The MiIcroChip WED Site.......uuiiiiiiiiieeeeeeeeeeeeeeeeee et 26
Customer Change Notification Service...........cccoeiiiiii e, 26
L0101y (o]0 g LT RS 10T o] oL o FEU PP PPPPPPPPPPPPPN 26
Microchip Devices Code Protection Feature...........ccccocceiiiiiiivaeaaas 26
[I=To = 1 N o) 1o ST EPPTPPOPPPPPPPPPR 27
TrAdEMATKS. ... e e e 27
Quality Management System Certified by DNV........oooiiiiiiiiiieeeee e 28
Worldwide Sales and SEIVICE.........ooiiuiiiiiiii e 29

© 2017 Microchip Technology Inc. User Guide DS50002636A-page 3



ATmega168PB Xplained Mini

1. Introduction

1.1 Features
The ATmega168PB Xplained Mini evaluation kit provides a development platform for the ATmega168PB.

Key Features

*  On-board debugger with full source-level debugging support in Atmel Studio
*  Auto-ID for board identification in Atmel Studio

*  Access to all signals on the target MCU

*  One green mEDBG status LED

*  One yellow user LED

*  One mechanical user push button

*  Virtual COM port (CDC)

»  External target CLK 16MHz at 5V, 8MHz at 3.3V

« USB powered

3.3V regulator

*  Arduino shield compatible footprints

»  Target SPI bus header footprint

»  Xplained Pro extension headers can easily be strapped in

1.2 Board Overview
A brief overview of the default kit configuration, headers, and connectors.
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Figure 1-1. ATmega168PB Xplained Mini Headers and Connectors
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Table 1-1. Default Configurations

m Default configuration Other settings

Kit power source (J300) 5.0V USB powered External input VIN ()

Target power (J301) 5.0V USB powered 3.3V from the on-board regulator
(1)

ATmega168PB clock 16MHz mEDBG clock ) Internal oscillator (3)

n ICr)‘::nging the default settings require modification of the kit using a soldering iron.
1) Details on how to change the power settings are described in Power Sources.
2) Details on the mEDBG clock are described in Xplained Mini Clock Output.
3) Debugging through debugWIRE may be disabled if the internal oscillator is used.
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2. Getting Started

21 Xplained Mini Quick Start
Steps to start exploring the Xplained Mini platform:
1. Download Atmel Studio.
2. Launch Atmel Studio.

3. Connect a USB cable (Standard-A to Micro-B or Micro-AB) between the PC and the USB port on
the Kkit.

When the Xplained Mini kit is connected to your computer for the first time, the operating system will
perform a driver software installation. The driver file supports both 32- and 64-bit versions of Microsoft®
Windows® XP, Windows Vista®, Windows 7, Windows 8, and Windows 10. The drivers for the kit are
included with the Atmel Studio.

Once the Xplained Mini board is powered the green status LED will blink and Atmel Studio will autodetect
which Xplained Mini board is connected. Atmel Studio will present relevant information like data sheets
and kit documentation. The ATmega168PB device is programmed and debugged by the on-board Mini
Embedded Debugger and therefore no external programmer or debugger tool is required.

2.2 Design Documentation and Related Links

The most relevant documents and software for the evaluation kit are available here:
ATmega168PB Xplained Mini website - Kit information, latest user guide, and design documentation.
ATmega168PB Xplained Mini on Microchip Direct - Buy this kit on microchipDIRECT.

*  Atmel Studio - Free IDE for the development of C/C++ and assembler code for microcontrollers.

+  Xplained products - Xplained evaluation kits are a series of easy-to-use evaluation kits for
Microchip microcontrollers and other Microchip products.

— Xplained Nano: used for low pin-count devices and provides a minimalistic solution with
access to all /0 pins of the target microcontroller.

— Xplained Mini: used for medium pin-count devices and adds Arduino Uno compatible header
footprint and a prototyping area.

— Xplained Pro: used for medium to high pin-count devices that features advanced debugging
and standardized extensions for peripheral functions.

Note: All the above kits have on-board programmers/debuggers, which creates a set of low-cost
boards for evaluation and demonstration of features and capabilities of different Microchip products.
* Atmel Spaces - Open Source projects for Xplained Mini.

* http:/istart.atmel.com/ - Atmel START is an online tool to help you select and configure software
components and tailor your embedded application in a usable and optimized manner.

2.3 Programming and Debugging

231 Programming the Target Using mEDBG

Using the Embedded Debugger on the ATmega168PB Xplained Mini board to program the
ATmega168PB.
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1. Connect the Xplained Mini USB to the PC.

2. Go to Atmel Studio: Click the Tools tab, select Device Programming, and select the connected
mEDBG as Tool with Device as ATmega168PB and Interface to ISP, click Apply.

3. Select "Memories", locate the source .hex or .elf file, and click Program.

mEDBG (ATML2222050200003079) @ - Device Programming " - c— P i)
! Tool Device Interface Device signature Target Voltage I
mEDBG v | ATmegal68PB  ~ (ISP = ||Apply| — OxIE9415 d] 50V |Read| @|
Interface settings Device
Teol information Erase Chip ~ | [ Erase now |
Device information Flash (16 KB}
Oscillator Calibration ChUsers\thjoernvald\DocumentsisvniATmegal68_Xplained_Mini\07_Firmware\rev01_verification i E\
Memaories Erase device before programming
P Ve Read...
Fuses \J'enfy Flash after programming regram ‘ [ ecify | [ £ |
Lock bits EEPROM (512 bytes)
Production file [:‘
[¥] Verify EEPROM after programming Read.. |

[~ ] Reading device ID..OK

Close

4. NOTE: If a previous debug session was not closed by selecting "Disable debugWIRE and Close" in
the Debug menu, the DWEN fuse will be enabled and the target will still be in debug mode, i.e. it
will not be possible to program the target using the ISP interface.

Eror | L e it
@ Erasing device failed

v | Details

5. If the source file contains fuse settings, select "Production file" and upload the .elf file to program
the fuses.

6. Select "Fuses" to program the fuses manually. Set the fuse(s) and click "Program". Recommended
fuse settings:
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mEDBG (ATML2222050200003079) @ - Device Programming . - —— l 7 iE-J
| oo Device Interface Device signature Target Voltage |
mEDBG ~ | ATmegel68PE - [1SP ~ | Apply|  O:EMIS Read| = 50V [Read| @|
Interface settings Fuse Name Value

Tool information @ BooTszZ 128W_1F80 'l

@BOOTRST  [O
Device information .

GhRsTDISEL [
Oscillator Calibration .
Memor ) DWEN B
emaries )

(#) SPIEN
Fuses )

@woton [0
Lock bits ;

() EESAVE

Production file (& BODLEVEL @‘
(¥ ckove B
@ ckour ]
() SUT CKSEL | EXTCLK 6CK 14CK 65M5 = |
Fuse Register  Value
EXTENDED  OxFF

HIGH 0xDE
Low OxEQ
Capy to clipboard
Auta read )
[] Veerify after pragramming [ Pragram ‘ [ Verify ‘ [ Read ‘

E\ Read registers...OK

Close

Debugging the Target Using mEDBG

Using the Embedded Debugger on the ATmega168PB Xplained Mini board to debug the ATmega168PB
via debugWIRE.

Start Atmel Studio.

Connect the Xplained Mini USB to the PC.

Open your project.

Click the "Project" tab and select the project "properties", click the "Tools" tab, and select mMEDBG
as debugger and debugWIRE as interface.

Click the "Debug" tab and select "Start Debugging and Break".

Atmel Studio will display an error message if the DWEN fuse in the ATmega168PB is not enabled,
click YES to make Studio set the fuse using the ISP interface.

Launch Failed [

powobd=

o o

Failed to launch debug session with debugWIRE. This could be caused by reset line
circuitry or disabled debugWIRE interface. Make sure that the reset line is free before
continuing. Do you want to use 5Pl to enable the DWEN fuse?

7. A debug session is started with a break in main, the debugging can start.

8. To exit debug mode, select "Disable debugWIRE and Close" in the Debug tab. This will disable the
DWEN fuse.
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Info:

ﬂ If debug mode is not exited by selecting "Disable debugWIRE and Close" in the Debug menu,
the DWEN fuse will be enabled and the target will still be in debug mode, i.e. it will not be
possible to program the target using ISP.

If any other CPU CLK than the external CLK supplied by the mEDBG is used, the debugWIRE
is not guaranteed to work.

Applying a signal to J202/RESET (the RESET_SENSE signal) while debugging may result in
unexpected behavior. This signal is NOT available during a debugging session because the
RESET line is actively used by the debugWIRE interface.

Programming the Target Using an External Programmer
How to program the target ATmega168PB using the AVR® JTAGICE mkll, JTAGICE3, Atmel-ICE, or other
programmers.

1. Connect the External Programmer USB to the PC.

2. Connect the External Programmer to the ATmega168PB Xplained Mini board ISP connector.

3. Go to Atmel Studio: Click the Tools tab, select Device Programming, and select the External
Programmer connected as Tool with Device as ATmega168PB and Interface to ISP, click Apply.
4. Select "Memories", locate the source .hex or .elf file, and click Program.

Programming the ATmega32U4 Using an External Programmer
How to program the ATmega32U4 using the AVR JTAGICE mkll, JTAGICE3, Atmel-ICE, or other
programmers.

1. Connect the External Programmer USB to the PC.

2. Connect the External Programmer to the ATmega168PB Xplained Mini board JTAG connector.

3. Go to Atmel Studio: Click the Tools tab, select Device Programming, and select the connected
mEDBG as Tool with Device as ATmega32U4 and Interface to JTAG, click Apply.

4. Select "Memories", locate the source .hex or .elf file, and click Program.

Atmel-ICE (J41800001190) @ - Device Programming - c— [
Ml 7ol Device Interface Device signature Target Voltage
AtmelICE v | ATmega32us = [1TAG | [apply| = Read| - [Read| (33

Interface settings Device
Tool information Erase Chip 'l Erase now |

Device information Flash (32 KB}
Oscillator Calibration Tmega328P8_Xplained_Min\07_Firmware\shipment,_firmware\medbg_images-20038\medbghex * [ . |

Memories 9] Erase device before programming

] Verify Flash after programming Pogram | [ Veriy | [ Read. ]

Fuses
Lock bits EEPROM (1 KB)

. . C\Users\thjeernvold\Documents\svnh\ATSAMD10_Xplained_MinhATSAMDL0-XMINDD7 _Firmwareh, ~ E‘
Production file

] Verify EEPROM after programming Program | [ very | [ Resd. |

[+] ok

5. Select "Fuses" to program the fuses manually. Set the fuse(s) and click "Program". Recommended
fuse settings:
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Atmel-ICE (41200000092) - Device Pregramming -5zl
Tool Device Interface Device signature Target Voltage

AtmelICE v | ATmega32U4  ~ [JTAG - |[Apply| | 0:dE9587 Read| | 50V ||Read| @|

Interface settings Fuse Name Value

(@BODLEVEL [Bruwn-ouldete:tlon at VCC=20V "

Tool information

Device information @rwae

) @OCDEN B

Oscillator calibration (ZIJTAGEN

Memaries @SPEN

Fuses @.WDTQN B

Lack bits (@)EESAVE
@BOOTSZ

[Boot Flash size=2048 words start address=53800
@BOOTRST [

@ ckove

@cxout

(DSUTCKSEL [ by, Crystal Osc. 80~ MHz; Start-up time: 258 CK + 65 ms =

Production file

Fuse Register  Value
EXTENDED  0xf6

HIGH 0x91
Low OxlE

Capy ta clipboard
[¥] Auto read \
[¥] Verify after programming [Program H WVerify H Resd |

E\ Read registers..OK

Close

Warning: Changing the firmware in the ATmega32U4 will remove the programming and
debugging capabilities of the mEDBG. If the EEPROM is altered the mEDBG may not be
recognized by Atmel Studio anymore.

2.3.5 Programming the ATmega32U4 Using a Bootloader
This section describes how to use the bootloader to program the ATmega32U4.

1. Launch Atmel Studio.

2. Short strap J102.

3. Open the programming dialog, select the bootloader in the tool menu.

4. Connect the ATmega168PB Xplained Mini board USB connector to the PC.
5. Select Device = ATmega32U4 (Device - Select).

6. Select USB communication (Ctrl+U).

7. Select the memory area to program (use the toggle memory button).

8. Select Load Hex file (Ctrl+L).

9. Select Programming Options.

10. Click "Run", observe the status in the status field.

Warning: Changing the firmware in the ATmega32U4 will remove the programming and
debugging capabilities of the mEDBG. If the EEPROM is altered the mEDBG may not be
recognized by Atmel Studio anymore.
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Xplained Mini

Xplained Mini is an evaluation platform that provides a set of small boards with access to all
microcontroller I/Os. The platform consists of a series of low-pin-count Microcontroller (MCU) boards,
which are integrated with Atmel Studio to present relevant user guides, application notes, datasheets,
and example code. The platform also features a Virtual COM port for serial communication to a host PC.

Mini Embedded Debugger

The ATmega168PB Xplained Mini contains the Mini Embedded Debugger (nEDBG) for on-board
programming and debugging. The mEDBG is a composite USB device of two interfaces; a debugger and
a Virtual COM Port.

Together with Atmel Studio, the mEDBG debugger interface can program and debug the ATmega168PB.
On ATmega168PB Xplained Mini, the ISP/dW interface is connected between the mEDBG and the
ATmega168PB.

The Virtual COM Port is connected to a UART on the ATmega168PB and provides an easy way to
communicate with the target application through the terminal software. It offers variable baud rate, parity,
and stop bit settings.

Note: The settings on the ATmega168PB must match the settings given in the terminal software.

Info: The virtual COM port in the mEDBG requires the terminal software to set the data

ﬂ terminal ready (DTR) signal to enable the UART pins connected to the ATmega168PB. If the
DTR signal is not enabled the UART pins on the mEDBG are kept in high-z (tri-state) rendering
the COM port unusable. The DTR signal is automatically set by some terminal software, but it
may have to be manually enabled in your terminal.

The mEDBG controls one status LED on the ATmega168PB Xplained Mini. The table below shows how
the LED is controlled in different operation modes.

Table 3-1. mEDBG LED Control

Operation mode Status LED

Power up LED is briefly lit
Normal operation LED is not lit
Programming Activity indicator; the LED flashes when

programming/debugging with the mEDBG

Xplained Mini Clock Output

The mEDBG outputs its CPU clock on a pin. This clock pin is connected to the ATmega168PB clock input
and is used to have a synchronous clock with the mEDBG to enable debugging through debugWIRE.

To disconnect the external clock to the ATmega168PB a 0Q resistor or strap has to be removed from the
footprint, as shown in the figure below (R109).
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Figure 3-1. External Clock Footprint
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The mEDBG CPU clock frequency depends on the selected voltage, see the table below.
Table 3-2. CPU Clock vs. Voltage

3.3V 8MHz

5.0V 16MHz

mEDBG Configuration

The operation of the mEDBG can be configured by writing registers in the mEDBG. No configuration is
required for default operation.

mEDBG Low Power Modes

There are two modes that enable the mEDBG to save power when connected to an external power
source.

EOF mode, where the mEDBG is disabled. When enabled the ATmega32U4 will enter sleep mode if the
USB does not enumerate within 5 seconds of power-up. In this mode, the external clock is not available
to the target MCU.

LOWP mode, where the mEDBG is set to run at 1MHz. Saving power while maintaining the USB
connection for the COM port. The external clock will be 1MHz.

Table 3-3. Low Power Modes Operation

m External CLK COM port ISP/dW program ISP/dW debug

disabled disabled disabled disabled
LOWP forced 1MHz enabled useless useless
Factory settings enabled enabled enabled enabled

mEDBG Fuse Filter

The mEDBG does not initially allow users to program all fuses of the target device through Atmel Studio,
as a filter is implemented to protect certain fuses. The protected fuses are different for every product
using the mEDBG and are typically clock related fuses that could be set to invalid configurations.

The fuse protection can be disabled by writing the FUSE bit to 0.
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ATmega168PB Xplained Mini

does not prevent users from setting fuses freely using the command line interface atprogram

ﬂ Info: The fuse filter prevents users from changing critical fuses using Atmel Studio; however, it
bundled with Atmel Studio.

3.23 mEDBG Command Line Interface
The configuration of the mEDBG can be changed using a simple command line interface available on
Atmel Spaces Releases (mMEDBG_script.zip).

The CLlI is written for Python® 2.7 and may work on other Python 2.x versions. Python can be
downloaded from Python.

The CMSIS-DAP commands used by the CLI are not supported in early mEDBG firmware versions. To
upgrade the firmware, download the latest version of Atmel Studio and connect to the mEDBG with the
programming dialog.

The register definitions are available in the following sections.

Related Links
SUFFER

3.24 Super User Fantastic Feature Enable Register

The Super User Fantastic Feature Enable Register allows the user to modify the behavior of the mEDBG.

Name: SUFFER
Offset: 0x0120
Reset: OxFF
Property: N/A

Bit 7 6 5 4 3 2 1 0
EOF LOWP FUSE
Access R/W R/W R/W
Reset 1 1 1

Bit 2 — EOF: Extended Off

Writing the EOF bit to 1 sets default operation. Writing the EOF bit to 0 enables the extended off power
mode. If no USB enumeration is successful within five seconds of power up, the mEDBG enters deep
sleep.

Bit 1 - LOWP: Low Power
Writing the LOWP bit to 1 sets the system clock to its default value. Writing the LOWP bit to 0 enables
low power mode. The mEDBG is set to run at 1MHz, which decreases the power usage.

Bit 0 — FUSE: FUSE Protection

Writing the FUSE bit to 1 enables fuse protection when using Atmel Studio. The fuse protection prevents
modification of specific fuses in the ATmega168PB target device that could make the mEDBG on the
ATmega168PB Xplained Mini not usable. Writing the FUSE bit to 0 removes all protection of fuses in the
ATmega168PB target device.
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Warning: Writing the FUSE bit to 0 enables modification of all fuses in the ATmega168PB.

A Setting wrong fuse settings may render the mEDBG not usable on the ATmega168PB Xplained
Mini. As an example; if an invalid clock setting is set, a recovery may require an external
debugger.

mEDBG Firmware Upgrade and Manual Bootloader Entry
The mEDBG firmware is updated through the programming dialog in Atmel Studio.
If you are unable to upgrade the mEDBG firmware on your ATmega168PB Xplained Mini, you can try the

command line utility atfw.exe provided with the Atmel Studio. atfw.exe is located in the atbackend folder in
your Atmel Studio install location.

To manually upgrade the firmware, run the following command:
atfw.exe -t medbg -a ..\tools\ mMEDBG\medbg_fw.zip

If atfw.exe is unable to find the mEDBG it may be required to force the ATmega32U4 (mEDBG) to enter
its bootloader. To force the bootloader entry, short-circuit the BOOT pads (J102) and toggle power to the
ATmega168PB Xplained Mini board. Run the atfw command above. When the firmware is upgraded,
remove the power from the kit and remove the short-circuit of J102.

Figure 3-2. Force Boot Jumper
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Hardware User Guide

The following sections describe the implementation of the relevant peripherals, headers, and connectors
on the ATmega168PB Xplained Mini and their connections to the ATmega168PB. The tables of
connections in the sections below also describe which signals are shared between the headers and on-
board functionality.

The figure below shows the assembly drawing of the ATmega168PB Xplained Mini to help identification of
components.
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Figure 4-1. ATmega168PB Xplained Mini Assembly Drawing
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Power Sources

The ATmega168PB Xplained Mini kit can be powered by a USB or an external voltage input VIN. The
default power source is 5.0V from a USB. The USB port is protected with a 500mA PTC resettable fuse.

The ATmega168PB is powered from the 5.0V USB voltage by default.

The figure below shows the possible kit power supply connections.
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Figure 4-2. Power Supply Block Diagram
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The input voltage select jumper (J300, 3-pin header footprint) can be soldered in to select between power
from the USB port or from the VIN pin on the Arduino power header footprint. By default, the selector is
bypassed with a 0Q resistor (R300) to connect the USB voltage to the on-board 3.3V/150mA regulator
and target voltage select header.

The target voltage select jumper (J301, 3-pin header footprint) can be soldered in to select between the
on-board 3.3V regulator or the voltage from the input voltage select jumper (J300). The selector is
bypassed with a 0Q resistor (R301) to connect the kit input voltage to the ATmega168PB and mEDBG.

Important: If the target voltage and input voltage select headers are soldered in and used with
a jumper, the bypass 0Q resistors have to be removed to avoid contention.

Board Assembly

The Xplained Mini board can easily be assembled into a product prototype for software development and
hardware verification. All signals of the ATmega168PB are available in the Xplained Mini board connector
grid, enabling easy connection of external sensors and output devices in order to prototype the customer
specific application.

Connecting an Arduino Shield
Arduino® shields can be mounted in the marked positions (J200, J201, J202, J203, and J204).

Warning: The ATmega168PB Xplained Mini connects VCC_TARGET to the Arduino SPI

A connector, while all Arduino boards connect VCC_P5VO0 to the same pin. The VCC_TARGET
may be either 3.3V or 5.0V depending on the configuration of the kit if the kit is configured for
3.3V operation. Connecting an Arduino shield may damage the board permanently. It is not
recommended to solder the SPI connector when using Arduino shields if not strictly necessary.
If the connector is required it is recommended to remove pin two from the SPI connector.

Target Headers and Connectors

Target Digital 1/0
The J200 and J201 headers provide access to the ATmega168PB digital 1/O pins.
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Table 4-1. J200 Digital /0 High Byte Header

1 PBO

2 PB1

3 PB2 SS, SPI Bus Master Slave select

4 PB3 MOSI, SPI Bus Master Output/Slave Input

5 PB4 MISO, SPI Bus Master Input/Slave Output

6 PB5 SCK, SPI Bus Master clock Input

7 GND

8 AREF

9 PC4 SDA, 2-wire Serial Bus Data Input/Output Line. Shared with
ADCA4.

10 PC5 SCL, 2-wire Serial Bus Clock Line. Shared with ADCS5.

Table 4-2. J201 Digital /0 High Low Header

2010 ATmegatesPRpn R
1 PDO RXD (ATmega168PB USART Input Pin)

PD1 TXD (ATmega168PB USART Output Pin)

PD2

PD3

PD4

PD5

PD6

PD7

o N o o B~ WDN

4.3.2 Board Power Header
The J202 header enables connection to the ATmega168PB Xplained Mini power system.

Table 4-3. J202 Power Header

1 NC

2 VCC_TARGET The power source selected for the target (select by J301)

3 RESET_SENSE | This is a RESET signal monitored by the mEDBG. If pulled low the
target RESET line will be pulled low by the mEDBG. The ATmega32U4
internal pull-up is enabled. This signal is not available during debugging.

4 VCC_P3V3 The 3.3V regulator output

5 VCC_P5V0 The selected power source (VIN or VBUS selected by J300)
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6 GND
7 GND
8 VCC_VIN The external power source connection (connected to J300 pin 3)

Target Analogue I/O
The ATmega168PB ADC input pins are available in the J203 header.

AREF is available in J200 pin 8.
Table 4-4. J203 Analogue Header

1 PCO ADC Input Channel 0
2 PC1 ADC Input Channel 1
3 PC2 ADC Input Channel 2
4 PC3 ADC Input Channel 3
5 PC4 ADC Input Channel 4
6 PC5 ADC Input Channel 5

Target Programming

The J204 header enables direct connection to the ISP bus with an external programmer for programming
of the ATmega168PB.

Table 4-5. SPI Header

1 PB4 MISO

2 VCC target
3 PB5 SCK

4 PB3 MOSI

5 PC6 RESET

6 GND

Target Additional I/0
Signals not available in any of the headers or connectors are available in column 5 of the grid.

Table 4-6. Additional I/O

ATmega168PB pin Grid position

PEO1 J5
PEO2 15
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ATmega168PB pin Grid position

PEO3 H5
PEO4 G5

4.4 Target Peripherals
The ATmega168PB Xplained Mini has one LED and one push button.

Figure 4-3. ATmega168PB Xplained Mini Peripherals

]
3

SW200 D200

441 Push Button
A general purpose push button, SW200, is connected to PB7.
Figure 4-4. User Button

USER BUTTON
VCC_TARGET

R209
100k

PB7

3
4

SKRAAKEO010

SW200

1
[ 2]
|

—(C204
100n

GND

4.4.2 User LED
There is one yellow LED, D200, available for use by the application SW.

The LED is connected to ATmega168PB pin 17 - PB5, the SCK signal from the mEDBG is in 3-state
when not used.
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Figure 4-5. User LED
USER LED

PB5

R200
{1k}

D200
LED 12
\\:EL17-21UYC/A3

GND

mEDBG

The ATmega168PB Xplained Mini board has an embedded debugger/programmer enabling debugging
and programming of the ATmega168PB without any additional external equipment.

mEDBG COM Port Connection
The mEDBG provides a CDC COM port connection when connected to a USB host device.

The mEDBG (ATmega32U4) USART is used for communication with the CDC COM port. The USART
TX/RX signals are available on the J104 header and are also connected to the ATmega168PB via 0Q

resistors enabling easy disconnect from the ATmega168PB, if needed. The RX/TX silk screen notation
next to J104 refers to the RX and TX pins of the mEDBG (ATmega32U4).

Table 4-7. J104 USART Header

1-USART TxD PD3 PDO (RxD) TxD out from ATmega32U4
2 - USART RxD PD2 PD1 (TxD) RxD in to ATmega32U4

mEDBG JTAG Interface

The mEDBG (ATmega32U4) JTAG interface is available for programming and debugging of the
ATmega32U4 on the 50-mil header in the upper right corner of the kit.

Table 4-8. J100 JTAG Header

1 TCK
2 GND
3 TDO
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4 VCC_BOARD ATmega32U4 V¢ (J301 pin 2)
5 TMS

6 RESET Connected to ATmega32U4 only
7 NC

8 NC

9 TDI

10 GND

Extension Header Area

The marked area on the grid I7 to R8 can be used for strapping in an Xplained Pro extension header or a
10-pin legacy Xplained/RZ600 header.

Figure 4-6. Extension Header Area

Extension header area

SPI_SS SPI_MOSI
SPI_MISO S SPI_SCK

The SPI bus signals are available close to the header at row J and K, enabling easy connection to header
pin 15 to 18.

Using pin 11 to 20 enables connection of the 10-pin legacy header used on the RZ600 wireless modules
and the 10-pin Xplained sensor modules.

The general bus connections for an Xplained Pro Extension board are indicated in the table below.
Detailed wiring can be found in the selected extension board documentation.

Table 4-9. Extension Header Typical Signals

1 ID Communication line to the ID chip on the Xplained extension board

2 GND Ground

3 ADC(+) Analog to digital converter, alternatively positive part of differential ADC
4 ADC(-) Analog to digital converter, alternatively negative part of differential ADC
5 GPIO1 General purpose I/O
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6 GPIO2 General purpose I/O
7 PWM(+) Pulse width modulation, alternatively positive part of differential PWM
8 PWM(-) Pulse width modulation, alternatively negative part of differential PWM
9 IRQ/GPIO Interrupt request line and/or general purpose 1/0
10 SPI_SS_B/ Slave B select for SPI and/or general purpose /O
GPIO
11 I2C_SDA Data line for I12C interface
12 12C_SCL Clock line for I12C interface
13 UART_RX Receiver line of ATmega168PB USART
14 UART_TX Transmitter line of ATmega168PB USART
15 SPI_SS A Slave A select for SPI
16 SPI_MOSI Master out slave in line of serial peripheral interface
17 SPI_MISO Master in slave out line of serial peripheral interface
18 SPI_SCK Clock for serial peripheral interface
19 GND Ground
20 VCC Power for extension board

Factory Programmed
The ATmega168PB is preprogrammed with a demo program; ReMorse.

The source code is available in Atmel Spaces.

When the CDC COM port is connected to a terminal window (9600 8N1), the text you write will be
transmitted via the LED in Morse code. Any Morse code transmitted by using the button will be displayed
as text in the terminal window.

The ATmega32U4 is preprogrammed with the mEDBG firmware.
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Hardware Revision History and Known Issues

This user guide is written to reflect the latest available revision of the kit. This chapter contains
information about known issues, a revision history of older revisions, and how older revisions differ from
the latest revision.

Identifying Product ID and Revision

The revision and product identifier of Xplained Mini boards can be found in two ways; either through
Atmel Studio or by looking at the sticker on the bottom side of the PCB.

By connecting an Xplained Mini board to a computer with Atmel Studio running, an information window
will pop up. The first six digits of the serial number, which is listed under kit details, contain the product
identifier and revision.

The same information can be found on the sticker on the bottom side of the PCB. Most kits will print the
identifier and revision in plain text as AO9-nnnn\rr, where nnnn is the identifier and rr is the revision.
Boards with limited space have a sticker with only a data matrix code, which contains a serial number
string.

The serial number string has the following format:
"NNNNrrssssssssss”
n = product identifier
r = revision

s = serial number

The product identifier for ATmega168PB Xplained Mini is A09-2222.

Revision 5
Revision 5 is the initial release of ATmega168PB Xplained Mini. There are no known issues.
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6. Document Revision History

Document revision m Comment

A 08/2017 | Converted to Microchip format and replaced the Atmel document
number 42381B.

Restructured the document, added the Hardware Revision History and
Known Issues chapter.

42381B 09/2015 Updated version
42381A 10/2014 Initial document release
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The Microchip Web Site

Microchip provides online support via our web site at http://www.microchip.com/. This web site is used as
a means to make files and information easily available to customers. Accessible by using your favorite
Internet browser, the web site contains the following information:

*  Product Support — Data sheets and errata, application notes and sample programs, design
resources, user’s guides and hardware support documents, latest software releases and archived
software

* General Technical Support — Frequently Asked Questions (FAQ), technical support requests,
online discussion groups, Microchip consultant program member listing

* Business of Microchip — Product selector and ordering guides, latest Microchip press releases,
listing of seminars and events, listings of Microchip sales offices, distributors and factory
representatives

Customer Change Notification Service

Microchip’s customer notification service helps keep customers current on Microchip products.
Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata
related to a specified product family or development tool of interest.

To register, access the Microchip web site at http://www.microchip.com/. Under “Support”, click on
“Customer Change Notification” and follow the registration instructions.

Customer Support

Users of Microchip products can receive assistance through several channels:

*  Distributor or Representative

* Local Sales Office

»  Field Application Engineer (FAE)
*  Technical Support

Customers should contact their distributor, representative or Field Application Engineer (FAE) for support.
Local sales offices are also available to help customers. A listing of sales offices and locations is included
in the back of this document.

Technical support is available through the web site at: http://www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

*  Microchip products meet the specification contained in their particular Microchip Data Sheet.

*  Microchip believes that its family of products is one of the most secure families of its kind on the
market today, when used in the intended manner and under normal conditions.

*  There are dishonest and possibly illegal methods used to breach the code protection feature. All of
these methods, to our knowledge, require using the Microchip products in a manner outside the
operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is
engaged in theft of intellectual property.

*  Microchip is willing to work with the customer who is concerned about the integrity of their code.
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* Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their
code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the
code protection features of our products. Attempts to break Microchip’s code protection feature may be a
violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software
or other copyrighted work, you may have a right to sue for relief under that Act.

Legal Notice

Information contained in this publication regarding device applications and the like is provided only for
your convenience and may be superseded by updates. It is your responsibility to ensure that your
application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS
CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE.
Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life
support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend,
indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual
property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR Freaks, BeaconThings,
BitCloud, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, KeeLoq, KeelLoq logo,
Kleer, LANCheck, LINK MD, maXStylus, maXTouch, MediaLB, megaAVR, MOST, MOST logo, MPLAB,
OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, Prochip Designer, QTouch, RightTouch, SAM-BA,
SpyNIC, SST, SST Logo, SuperFlash, tinyAVR, UNI/O, and XMEGA are registered trademarks of
Microchip Technology Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, EtherSynch, Hyper Speed Control, HyperLight
Load, IntelliMOS, mTouch, Precision Edge, and Quiet-Wire are registered trademarks of Microchip
Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, Anyln, AnyOut, BodyCom,
chipKIT, chipKIT logo, CodeGuard, CryptoAuthentication, CryptoCompanion, CryptoController,
dsPICDEM, dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, EtherGREEN, In-Circuit Serial
Programming, ICSP, Inter-Chip Connectivity, JitterBlocker, KleerNet, KleerNet logo, Mindi, MiWi,
motorBench, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient
Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, PureSilicon, QMatrix, RightTouch logo, REAL
ICE, Ripple Blocker, SAM-ICE, Serial Quad I/O, SMART-I.S., SQI, SuperSwitcher, SuperSwitcher Il, Total
Endurance, TSHARC, USBCheck, VariSense, ViewSpan, WiperLock, Wireless DNA, and ZENA are
trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.
Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestlIC is a registered trademark of Microchip Technology Germany Il GmbH & Co. KG, a subsidiary of
Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.

© 2017, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.
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ISBN: 978-1-5224-1982-2

Quality Management System Certified by DNV

ISO/TS 16949

Microchip received ISO/TS-16949:2009 certification for its worldwide headquarters, design and wafer
fabrication facilities in Chandler and Tempe, Arizona; Gresham, Oregon and design centers in California
and India. The Company’s quality system processes and procedures are for its PIC® MCUs and dsPIC®
DSCs, KEELOQ® code hopping devices, Serial EEPROMSs, microperipherals, nonvolatile memory and
analog products. In addition, Microchip’s quality system for the design and manufacture of development
systems is ISO 9001:2000 certified.
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